WARRANTY

Tektronix warrants that the products that it manufactures and sells will be free from defects in materials and workmanship for a period of one (1) year from the date of shipment. If a product proves defective during this warranty period, Tektronix, at its option, either will repair the defective product without charge for parts and labor, or will provide a replacement in exchange for the defective product.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration of the warranty period and make suitable arrangements for the performance of service. Customer shall be responsible for packaging and shipping the defective product to the service center designated by Tektronix, with shipping charges prepaid. Tektronix shall pay for the return of the product to Customer if the shipment is to a location within the country in which the Tektronix service center is located. Customer shall be responsible for paying all shipping charges, duties, taxes, and any other charges for products returned to any other locations.

This warranty shall not apply to any defect, failure or damage caused by improper use or improper or inadequate maintenance and care. Tektronix shall not be obligated to furnish service under this warranty a) to repair damage resulting from attempts by personnel other than Tektronix representatives to install, repair or service the product; b) to repair damage resulting from improper use or connection to incompatible equipment; c) to repair any damage or malfunction caused by the use of non-Tektronix supplies; or d) to service a product that has been modified or integrated with other products when the effect of such modification or integration increases the time or difficulty of servicing the product.

THIS WARRANTY IS GIVEN BY TEKTRONIX IN LIEU OF ANY OTHER WARRANTIES, EXPRESS OR IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. TEKTRONIX’ RESPONSIBILITY TO REPAIR OR REPLACE DEFECTIVE PRODUCTS IS THE SOLE AND EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR BREACH OF THIS WARRANTY. TEKTRONIX AND ITS VENDORS WILL NOT BE LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES IRRESPECTIVE OF WHETHER TEKTRONIX OR THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES.
WARRANTY

Tektronix warrants that the media on which this software product is furnished and the encoding of the programs on the media will be free from defects in materials and workmanship for a period of three (3) months from the date of shipment. If a medium or encoding proves defective during the warranty period, Tektronix will provide a replacement in exchange for the defective medium. Except as to the media on which this software product is furnished, this software product is provided “as is” without warranty of any kind, either express or implied. Tektronix does not warrant that the functions contained in this software product will meet Customer’s requirements or that the operation of the programs will be uninterrupted or error-free.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration of the warranty period. If Tektronix is unable to provide a replacement that is free from defects in materials and workmanship within a reasonable time thereafter, Customer may terminate the license for this software product and return this software product and any associated materials for credit or refund.

THIS WARRANTY IS GIVEN BY TEKTRONIX IN LIEU OF ANY OTHER WARRANTIES, EXPRESS OR IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. TEKTRONIX' RESPONSIBILITY TO REPLACE DEFECTIVE MEDIA OR REFUND CUSTOMER'S PAYMENT IS THE SOLE AND EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR BREACH OF THIS WARRANTY. TEKTRONIX AND ITS VENDORS WILL NOT BE LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES IRRESPECTIVE OF WHETHER TEKTRONIX OR THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES.
# Table of Contents

General Safety Summary ................................................................. iii
Preface ......................................................................................... v
  Documentation ........................................................................ vi
  Video Clips ............................................................................ vii
  Contacting Tektronix ................................................................. vii

Basic Setups .................................................................................. 1
  Connecting Probes to the Target System ...................................... 1
  Basic Steps for Using the Logic Analyzer ...................................... 2
  EasySetup Wizard ...................................................................... 2
  Data Window Overview .............................................................. 2

Getting Acquainted with Your Instrument ...................................... 4
  Set the Default System ............................................................. 4
  Maximize the System Window .................................................... 4
  Turn On the Logic Analyzer Module ......................................... 5
  Configure the Setup Window ..................................................... 5
  Define the Trigger Window ....................................................... 11
  Define the Waveform Window ................................................... 12
  Acquire Data ........................................................................... 14
  Analyze the Acquired Data ....................................................... 15
  View Acquired Data with MagniVu High-Resolution Timing ......... 17

Saving Setups ............................................................................... 19

Triggering on a Glitch ................................................................. 20
  Loading Setups ....................................................................... 20
  Define the Glitch Trigger ......................................................... 21
  Acquire and View Glitches Using MagniVu High-Resolution Timing 22
  Acquire and View Glitches Using Deep Timing ......................... 23

State Acquisition ........................................................................ 24
  Configure the Setup Window .................................................... 24
  Configure the Trigger Window ................................................... 25
  Acquire Data ........................................................................... 26
  Configure the Listing Window .................................................. 26

Triggering on a Setup & Hold Violation ....................................... 28
  Configure the Trigger Window ................................................... 28
  Acquire and Measure the MagniVu High-Resolution Timing Data .................................................. 29
  Acquire and Analyze the Deep Timing Data ............................. 29

iView Integrated Measurements .................................................. 30
  Using the iView Wizard ............................................................ 30
  Acquiring the iView Data .......................................................... 31
  Adjusting the Time Alignment on the Logic Analyzer ............... 34

Index ......................................................................................... 37
General Safety Summary

Review the following safety precautions to avoid injury and prevent damage to this product or any products connected to it.

To avoid potential hazards, use this product only as specified.

*Only qualified personnel should perform service procedures.*

While using this product, you may need to access other parts of the system. Read the *General Safety Summary* in other system manuals for warnings and cautions related to operating the system.

**To Avoid Fire or Personal Injury**

*Use Proper Power Cord.* Use only the power cord specified for this product and certified for the country of use.

*Connect and Disconnect Properly.* Do not connect or disconnect probes or test leads while they are connected to a voltage source.

*Ground the Product.* This product is grounded through the grounding conductor of the power cord. To avoid electric shock, the grounding conductor must be connected to earth ground. Before making connections to the input or output terminals of the product, ensure that the product is properly grounded.

*Observe All Terminal Ratings.* To avoid fire or shock hazard, observe all ratings and markings on the product. Consult the product manual for further ratings information before making connections to the product.

Do not apply a potential to any terminal, including the common terminal, that exceeds the maximum rating of that terminal.

*Powering Off.* The power cord provides Mains disconnect.

*Replace Batteries Properly.* Replace batteries only with the proper type and rating specified.

*Do Not Operate Without Covers.* Do not operate this product with covers or panels removed.

*Use Proper Fuse.* Use only the fuse type and rating specified for this product.

*Avoid Exposed Circuitry.* Do not touch exposed connections and components when power is present.

*Do Not Operate With Suspected Failures.* If you suspect there is damage to this product, have it inspected by qualified service personnel.

*Do Not Operate in Wet/Damp Conditions.*

*Do Not Operate in an Explosive Atmosphere.*

*Keep Product Surfaces Clean and Dry.*

*Provide Proper Ventilation.* Refer to the manual's installation instructions for details on installing the product so it has proper ventilation.
Symbols and Terms

Terms in this Manual. These terms may appear in this manual:

**WARNING.** Warning statements identify conditions or practices that could result in injury or loss of life.

---

**CAUTION.** Caution statements identify conditions or practices that could result in damage to this product or other property.

---

Terms on the Product. These terms may appear on the product:

DANGER indicates an injury hazard immediately accessible as you read the marking.

WARNING indicates an injury hazard not immediately accessible as you read the marking.

CAUTION indicates a hazard to property including the product.

Symbols on the Product. The following symbols may appear on the product:

- CAUTION
- Refer to Manual
- WARNING
- High Voltage
- Protective Ground (Earth) Terminal
- Mains Disconnected (Off) (Power)
- Mains Connected (On) (Power)
- Standby
Preface

This manual describes the basic operation and concepts of the Tektronix Logic Analyzer series instruments. The TLA5000 Series Logic Analyzers are stand-alone products and the TLA700 Series Logic Analyzers are configurable modular products. The TLA700 Series Logic Analyzers can be configured with a variety of logic analyzer modules and pattern generator modules. The TLA700 Series Logic Analyzers and TLA5000 Series Logic Analyzers can be used with Tektronix oscilloscopes. The following instruments are supported by this manual:

- TLA5000 Series Logic Analyzers (TLA5201, TLA5202, TLA5203, TLA5204)
- TLA715 Series Portable Mainframes and their associated modules (TLA7Axx and TLA7NAx modules)
- TLA721 and TLA7XM Series Benchtop Mainframes and their associated modules (TLA7Axx and TLA7NAx modules)

Documentation

The following table lists related documentation available for your logic analyzer. The documentation is available on the TLA Documentation CD and on the Tektronix website (www.Tektronix.com).

<table>
<thead>
<tr>
<th>Item</th>
<th>Purpose</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>TLA Quick Start User Manual</td>
<td>High-level operational overview</td>
<td></td>
</tr>
<tr>
<td>(and related videos)</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>Online Help</td>
<td>In depth operation and UI help</td>
<td></td>
</tr>
<tr>
<td>Installation Quick Reference Cards</td>
<td>High-level installation information</td>
<td></td>
</tr>
<tr>
<td>Installation Manuals</td>
<td>Detailed first-time installation information</td>
<td></td>
</tr>
<tr>
<td>XYZs of Logic Analyzers</td>
<td>Introduction to logic analyzer basics</td>
<td><a href="http://www.Tektronix.com">link</a></td>
</tr>
<tr>
<td>TLA Product Specifications</td>
<td>Complete list of TLA product specifications</td>
<td></td>
</tr>
<tr>
<td>TPI.NET Documentation</td>
<td>Detailed information for controlling the logic analyzer using .NET</td>
<td></td>
</tr>
<tr>
<td>Field upgrade kits</td>
<td>Upgrade information for your logic analyzer product</td>
<td></td>
</tr>
<tr>
<td>Optional Service Manuals</td>
<td>Self-service documentation for modules and mainframes</td>
<td></td>
</tr>
</tbody>
</table>
Video Clips

Some of the examples in this document have accompanying video clips. The video clips are located on the TLA Documentation CD that came with this manual.

Contacting Tektronix

<table>
<thead>
<tr>
<th>Phone</th>
<th>1-800-833-9200 ¹</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>Tektronix, Inc.</td>
</tr>
<tr>
<td>Department or name (if known)</td>
<td>14200 SW Karl Braun Drive</td>
</tr>
<tr>
<td></td>
<td>P.O. Box 500</td>
</tr>
<tr>
<td></td>
<td>Beaverton, OR 97077</td>
</tr>
<tr>
<td></td>
<td>USA</td>
</tr>
<tr>
<td>Web site</td>
<td><a href="http://www.tektronix.com">www.tektronix.com</a></td>
</tr>
<tr>
<td>Sales support</td>
<td>1-800-833-9200, select option 1 ¹</td>
</tr>
<tr>
<td>Service support</td>
<td>1-800-833-9200, select option 2 ¹</td>
</tr>
<tr>
<td>Technical support</td>
<td>Email: <a href="mailto:techsupport@tektronix.com">techsupport@tektronix.com</a></td>
</tr>
<tr>
<td></td>
<td>1-800-833-9200, select option 3 ¹</td>
</tr>
<tr>
<td></td>
<td>6:00 a.m. - 5:00 p.m. Pacific time</td>
</tr>
</tbody>
</table>

¹ This phone number is toll free in North America. After office hours, please leave a voice mail message. Outside North America, contact a Tektronix sales office or distributor; see the Tektronix web site for a list of offices.
Basic Setups

For detailed installation information, refer to the installation reference card or to the installation manual that came with the instrument. After your instrument is properly installed, you are ready to begin basic operations.

Connecting Probes to the Target System

The logic analyzer has different methods of connecting probes to the target system. Refer to the illustration and connect your probes to the target system.

- **Square pin connectors.** Use general purpose probes to connect to the target system using square pin connectors.
- **Connectorless connectors.** Use land pattern probes for applications that connect many channels to connectorless compression contacts on the target system.
- **Mictor connectors.** Use Mictor connector probes for applications requiring many channels to be quickly connected using Mictor connectors or Mictor adapters.
Basic Steps for Using the Logic Analyzer

After you have connected your probes and powered on the instrument, use the System window to control and access the key features of your instrument. The basic steps for using the logic analyzer are summarized below. For detailed explanations of the steps and the contents of the System window, refer to the online help.

1. Turn on the logic analyzer module (default setting).
2. Use the Setup window to set up the logic analyzer channels, clocking, and memory depth.
3. Specify the triggering in the Trigger window.
4. Configure the Waveform window.
5. Acquire data.

EasySetup Wizard

The EasySetup Wizard appears when you first power on your instrument (unless it has been disabled previously). You can use the EasySetup wizard for initial setups. However, the examples in this document create basic setups without the wizard to help you learn how to use the instrument on a day-to-day basis.

Data Window Overview

Use data windows to display and analyze data acquired from your instrument. The Waveform and Listing windows are the default data windows. Create other kinds of data windows using the New Data Window wizard. Refer to the online help for detailed information on creating and using the various data windows.

Waveform Window

Use Waveform windows to display waveform data from the logic analyzer or from an external oscilloscope. Waveform windows are best used for diagnosing timing problems, measuring hardware timing-related characteristics, and verifying correct hardware operation by comparing recorded results against data sheet timing diagrams.

Listing Window

Use listing windows to display acquired data in a state table display. Listing windows can be used for state machine debug applications, tracing software execution, system optimization, and following data through a system design.
**Histogram Window**

Use Histogram windows to display acquired data as histograms. Histogram data is useful for evaluating the performance of software, such as determining which routines or functions take most of the time performing certain tasks.

**Source Window**

Use Source windows with Listing windows to track the execution of source code in software applications.

**Graph Window**

Use Graph windows to display the results of acquired data in a graph or chart format.

**Protocol Window**

Use Protocol windows to display and analyze protocol data.
Getting Acquainted with Your Instrument

The following sections show how to set up the logic analyzer and to do timing analysis using data from a simple D-type flip-flop. Flip-flops are versatile devices that serve as building blocks in digital systems. Although most flip-flops are buried inside complex ASICs and other devices, they are very useful to show hardware debugging techniques using a logic analyzer. The examples in this document use only a few channels to acquire data. However, you can easily expand the basic concepts to use logic analyzers with hundreds of channels.

Quick Tip

Refer to the video clip, Getting_Acquainted.mpg on the TLA Documentation CD for a short audio-visual version of this section of manual.

Set the Default System

Use the default system set up to start the instrument at a known starting point, such as the factory default settings. Power on the instrument and wait for the System window to appear. If the EasySetup wizard appears, exit the wizard.

1. Select Default System from the File menu
2. Click OK.

Maximize the System Window

Click the Maximize button to see and access all of the components in the System window.

Quick Tip

Use the toolbar buttons or the drop-down Window menu to navigate between windows. This avoids having to resize windows when navigating between them.
Turn On the Logic Analyzer Module

The logic analyzer may contain one or more modules that you can turn on and off.

- Click the On/Off button in the module icon to turn modules on or off. By default, all modules are turned on.

Configure the Setup Window

Use the following procedures to define data channels, set the clocking, set the probe threshold voltages, and to use other features of the Setup window.

**Open the Setup Window**

- Click **Setup** to open the Setup window.
Delete Unused Default Channel Groups

It is recommended that you delete unused channels to focus only on the channels that you need.

1. Position the mouse in the center of the Setup window, right-click, and select Delete All Groups.

2. Click Yes when you are prompted to confirm your action.
Create New Channel Groups

Channel groups are a collection of probe channels used to accomplish specific tasks. Probe channels are typically organized from the most significant bit (bit 7) to the least significant bit (bit 0) as shown in the probe channel table. Each probe channel can have a unique name that will appear in the data windows.

1. Enter a unique name for each probe channel.
   For this example, use C for the clock channel, D for the input, and Q for the output.

2. Enter a new name for each channel group.

3. Click the button to the left of the probe channel name to add the channel to the channel group. Repeat for each probe channel that you want to add to the current group. (This example has one probe channel per channel group.)
   The order in which you select the channels is the order the channels will be displayed, from the most-significant bit to the least-significant bit.

4. Repeat steps 2 through 3 to create multiple channel groups (Input and Output for this example).

Quick Tips

- To assign an entire probe group (such as A1) to a group name, select the group name and then click the button to the left of the A1 probe. All channels of that probe will be added to the group name; the channels will display from the most-significant bit to the least-significant bit.

- To display a single channel in a Listing window, create a group that contains that single channel.
Getting Acquainted with Your Instrument

Set the Memory Depth

Use the memory depth to define the number of data samples to acquire.

- Select a memory depth from the drop-down list. The selections vary depending on your logic analyzer.

Set the Clocking

When you select Internal clocking, the logic analyzer selects when data is sampled (sample point). Internal clocking is also known as timing acquisition.

When you use External (synchronous) clocking, the target system specifies the sample point by the external clock. External clocking is also known as state acquisition.

1. Select Internal from the drop-down list.
2. Set the sample period from the drop-down list (or use the default clocking of 2 ns).

Quick Tip

- Many clocking selections are available. Refer to the online help for information on other clocking types.
Check the Probe Activity

1. Click **Probes** to open the Probe Properties.

   The Probe Properties dialog box opens showing the probe activity. When the target system is off, or no probes are connected, there is no probe activity. The channels are shown as active low signals.

2. Turn on the target system (or connect the probes). The channels with signal activity are represented by up and down arrows.

   If there is no probe activity, check the following:
   - Check the probe connections.
   - Verify that the target system is powered on.
   - Check the probe threshold voltages.
Set the Probe Threshold Voltages

The threshold voltage must match that of the target system. To change the threshold voltages, use the following steps.

1. Click the Thresholds tab.
2. Enter a threshold voltage or select one from the drop-down list.
3. Click **Set All** to apply the threshold voltages to all probe inputs.
4. Click **Close**.

Return to the System Window

1. Click System button in the toolbar to return to the System window.
Define the Trigger Window

Use the Trigger window to tell the logic analyzer when to acquire data and display the results in a data window.

1. Click Trig to open the Trigger window.

2. From the Easy Trigger tab, select a trigger program from the list. For example, select Trigger immediately to trigger the instrument on any data. Use the area below the trigger program list to enter more details for the trigger programs, if needed.

3. Click and drag the Trigger Pos indicator to the point in memory where you want the instrument to trigger. The default selection is 50%.

Quick Tips

- Use EasyTrigger to define the trigger program for most applications; use PowerTrigger to customize the trigger program for specific needs.

- Select Force Main Prefill to ensure data is captured before the trigger point.
Define the Waveform Window

Default Waveform and Listing windows are provided for you. For most applications you will define the windows for your specific application. For this example, you will use the Waveform window.

Open the Waveform Window

1. Click the Waveform window icon.

Delete the Default Waveforms

1. Press the control key and select each waveform name that you want to delete.

2. Right-click and select **Delete Waveforms**.
Add Waveforms

Use the following steps to add the waveforms that you defined in the Setup window.

1. Right-click in the waveform label area and select Add Waveform.

2. Click the plus sign (+) beside each channel group to expand the group.

3. Press the Ctrl key while selecting each channel that you want to add to the Waveform window.

4. Click Add to add the waveforms.

5. Click Close.

Quick Tip

- Select By Name to add the probe channels to the Waveform window by their channel names. This is useful for groups that have only one channel.
Acquire Data

After you have defined all of the setups and connected the probes to the target system, you are ready to acquire data. You can acquire a single sequence of data, or you can continuously acquire data.

Acquiring a Single Acquisition

1. Click Run or push the Run/Stop button on the front panel.
   The Run button changes to Stop until the instrument has met the trigger conditions and has acquired the data. The button changes back to Run after data has been acquired.

2. If the instrument does not trigger, click Status to open the Status Monitor and use the information in the dialog box to see if the logic analyzer is still waiting for the trigger or if it has triggered and is filling its acquisition memory.

   When a trigger occurs the instrument displays the Clock, Input, and Output data in the Waveform window. The trigger point is represented by the red trigger marker (T).

Quick Tip

- The Tek icon in the upper-right corner of the instrument becomes animated while the instrument acquires data. Use the animated icon to verify that the instrument is acquiring data during long periods of inactivity on the screen.

Acquiring Repetitive Acquisitions

1. Click the Repetitive Run button to acquire data repetitively. The icon changes from an arrow to a loop.

2. Click Start to acquire data. The instrument will acquire data until you click Stop or until you click the Repetitive Run button again to change back to single run mode.
Analyze the Acquired Data

After you have acquired data you may want to adjust the Waveform window before analyzing data in detail.

Zooming Data

Use the following steps to zoom data.

1. Click and drag from left to right over the area you want to zoom to create a zoom box.

When you release the mouse, the Waveform window will display zoomed data.

2. Click the Zoom In button a few times to zoom the timing data samples.

Quick Tips

- Click and drag from the right to the left to zoom to the previous selection.
- Use the Zoom In and the Zoom Out buttons in the toolbar as an alternative method of zooming data.
**Using Cursors to Measure Waveform Data**

Use the cursors in the Waveform window to measure the time between edges of waveforms.

1. Click and drag Cursor 1 to the leading edge of one waveform.
2. Click and drag Cursor 2 to the leading edge of a second waveform.
3. Measure the time difference between the two cursors in the Delta Time box.

**Quick Tip**

- If the cursors do not appear in the Waveform window, use the right-click menu to move the cursors on screen (select Move Cursor 1 Here).
View Acquired Data with MagniVu High-Resolution Timing

MagniVu high-resolution timing provides 125 ps sampling on all waveforms to analyze waveform details that you may not see using Deep timing. It is like having two logic analyzers in one. Using a single probe you can view Deep timing data for long time spans and MagniVu high-resolution timing data for greater resolution at the area of interest.

Display the MagniVu Waveforms

The MagniVu high-resolution data is automatically acquired with each acquisition. However the waveforms may not be visible. Use the following steps to add MagniVu timing waveforms.

1. Right-click a waveform label, and select Add Waveform.

2. Select LA1: MagniVu from the Data Source drop-down list.

3. Click the plus sign (+) beside each channel group to expand the group.

4. Press the Ctrl key while selecting each channel that you want to add to the Waveform window.

5. Click Add to add the waveforms.

6. Click Close.
The MagniVu timing waveforms are added to the window in a different color so that you can easily tell the difference.

7. Click the Zoom Out button until you see the entire MagniVu timing waveforms.

Note that the MagniVu timing data is 16 K bits long as compared to the Deep timing data. Deep timing lets you acquire a large amount of data while MagniVu timing lets you focus on the details of the data.
Saving Setups

After defining your setup, you can save it for future use.

1. Select **Save System** from the File menu.

2. Select one of the following save options:
   - **Save all Acquired Data**
   - **Save only Unsuppressed Data**
   - **Don’t Save Acquired Data**

   See the online help for details on saving setups.

3. Enter a file name.

4. Click **Save**.

**Quick Tip**
- Save often to avoid losing critical setups and data.
Triggering on a Glitch

Use the following procedure to set up the logic analyzer to trigger on a glitch. Use the setups from the previous example, except as noted in the following procedures.

Loading Setups

Use the following steps to load the setup that you saved under *Getting Acquainted with Your Instrument*. (See page 19.)

1. Select **Load System** from the File menu.

2. Select the file name.

3. Click **Open**.

4. Click **Yes** when you are prompted to confirm your actions.
Define the Glitch Trigger

1. Click **Trig** to open the Trigger window.

2. Select **Trigger on glitch** from the Easy Trigger program list.

3. Click **Define Glitches**.

4. Select the groups that you want the logic analyzer to trigger on. Clear any other channels.
   
   You can trigger the logic analyzer on the groups that you want and avoid triggering on channels that may contain glitches that you don’t care about.

5. Click **OK**.
6. Adjust the Trigger position, if necessary.

7. Click Force Main Prefill.
   Selecting Force Main Prefill fills the memory with data before executing the trigger program. This feature allows you to view data before the trigger point.

Acquire and View Glitches Using MagniVu High-Resolution Timing

1. Click Run to acquire data. The logic analyzer will trigger when it finds a glitch.

2. Look for the trigger indicator in the Waveform window. The 125 ps MagniVu timing shows the glitch next to the trigger indicator.
   You may have to zoom the window to see the glitch.

Quick Tip
- If the trigger point does not appear on the screen, right-click and select Go To > Next Trigger.
Acquire and View Glitches Using Deep Timing

Use the following steps to acquire and view glitches using Deep timing mode.

1. Go to the Setup window and select **Glitches** from the Acquire drop-down list.

   Selecting Glitches turns on glitch storage and displays glitches in the Waveform window.

2. Click **Run** to acquire data.

   The glitch data is highlighted in red at every sample point for each channel in the Deep timing waveforms. The MagniVu timing waveforms show the high-resolution glitch data.
**State Acquisition**

You can also use the logic analyzer for state data analysis. Instead of displaying data in a Waveform window, you can view the data in tabular form in the Listing window. The following procedures provide examples using the Listing window.

**Quick Tip**
- Use the setup that you saved under *Getting Acquainted with Your Instrument.* (See page 19.) Make additional changes as noted in the following procedures.

**Configure the Setup Window**

State acquisition uses an external clock from the target system to tell the logic analyzer when to sample data. Perform the following steps to set up the logic analyzer to use an external clock to acquire data.

1. Open the Setup window and select **External** from the drop-down clocking list.
2. Select **Normal** from the Acquire drop-down list.
3. Click **More** to define the external clocking.
4. Select the rising edge of **CK0().**
5. Click **Close.**
Configure the Trigger Window

1. Click Trig button to open the Trigger window.

2. Select Trigger immediately.

3. Select Force Main Prefill.
Acquire Data

1. Click Run to acquire the data.
2. Zoom the data as necessary to view the acquired data.
   - The LA1: Clock(0) waveform data shows no changes because the data is sampled on each rising clock edge. Each tic mark of the Sample clock waveform represents a clock edge.
   - The MagniVu high-resolution data still displays timing data.

Configure the Listing Window

Use the Listing window to display State data. Complete the following steps to configure the Listing window.

1. Go to the System menu and click the Listing window icon to open the Listing window.

The listing window has no data in it. You need to add the data columns to the window to see the data.
2. Right-click in the data area and select *Add Column*.

3. Select *Clock*, and then click *Add* to add the Clock column to the Listing window.

4. Select the other columns and click *Add* until all of the columns that you want are added to the Listing window.

   The Sample and Timestamp columns already appear in the Listing window.

5. Click *Close*.

6. If desired, click and drag the Timestamp column to the right of the last column. Timestamps may be easier to read if they are to the right of the state data.

Note the data in the Listing window.

- The clock data appears as zeros because the data is sampled on the rising edge of the clock.
- The Input and Output data appear as ones and zeros.
- The Timestamp column lists the time between data samples.
- The trigger point is halfway through the data because the Trigger position was set to 50%.
Triggering on a Setup & Hold Violation

Use the Setup & Hold triggering to capture setup and hold violations. This example builds on the State Acquisition setups.

Configure the Trigger Window

Open the Trigger window, and then perform the following steps to define the Setup & Hold triggering.

1. Select Trigger on group setup/hold violation from the trigger program list.
2. Click the Define Violation... button.
   Define the setup and hold violation setups. The logic analyzer will test the setup and hold values against those in the target system.

3. Select the desired value for the Input group/channel setup time (3 ns in this example).
4. Select the desired value for the Input group/channel hold time (1 ns in this example).
5. Clear the checkboxes in the Clock and Output groups.
6. Click OK.
7. Click Force Main Prefill.
Acquire and Measure the MagniVu High-Resolution Timing Data

Click Run to acquire the data. View the data in the Waveform window.

The instrument triggers on the rising edge of the clock signal at the violation. Complete the following steps to measure the setup time.

1. Zoom the data as necessary to see the MagniVu waveforms.
2. Move Cursor 1 to the rising edge of the clock (same point as the trigger marker).
3. Move Cursor 2 to the data input transition.
4. Read the setup time from the Delta Time readout.

Acquire and Analyze the Deep Timing Data

You can change the acquisition mode in the Setup window to flag setup and hold violations using Deep timing.

1. Go to the Setup window and select Setup/Hold from the Acquire drop-down list.
2. Click Run to acquire the data.

The setup and hold violation area is highlighted in red for each setup and hold violation on the Deep timing waveform. Use the MagniVu timing to view and measure the actual details.
iView Integrated Measurements

You can use the iView feature to connect an external Tektronix oscilloscope to the logic analyzer, acquire data from both instruments, and display the results on the logic analyzer. This is useful for displaying the analog components of a signal in the same data window as the digital components.

These examples use the logic analyzer setups from Triggering on a Glitch. (See page 20.) In the following examples the logic analyzer and the oscilloscope will acquire the same glitch data. The logic analyzer captures the digital components and the oscilloscope captures the analog component.

Use the following steps to set up the oscilloscope for these examples. Refer to the documentation that came with your oscilloscope for operating instructions.

1. Connect the oscilloscope probe to the same signal source as the logic analyzer (for this example, connect to the Q output of the flipflop).
2. Power on the oscilloscope.
3. Press the Default Setup button on the oscilloscope, and then press the Autoset button. You should have a signal on the oscilloscope screen.

Using the iView Wizard

After completing the oscilloscope and logic analyzer setups, use the iView wizard to connect the two instruments together.

1. From the logic analyzer System drop-down menu, select Add iView External Oscilloscope . . . to start the iView wizard.
2. Follow the instructions on each page of the wizard to do the following steps:
   - Select the oscilloscope.
   - Connect the iView cable to the logic analyzer.
   - Connect the iView cable to the oscilloscope.
   - Verify the GPIB address of the oscilloscope.
   - Identify where to display the oscilloscope data.
   - Specify the triggering.
   - Verify the connections and setups.
3. Click Finish on the last page of the wizard.
The oscilloscope is added to the System window. The iView (oscilloscope) icon has buttons similar to those of the logic analyzer.

### Acquiring the iView Data

The next steps consist of acquiring the initial data, and then adjusting the data to properly view and analyze the data.

#### Acquire the Initial Data

1. Click **Run** to acquire and display waveform data from both instruments.
   
   Depending on the oscilloscope and your Waveform window settings, you may not see any waveform data from the oscilloscope.

2. Click the **Zoom Out** button a few times until you see the oscilloscope waveform.
The oscilloscope data appears on the right side of the Waveform window.

Note the delay from the time that the logic analyzer triggered data to the time that the oscilloscope triggered data. The delay occurs between the time the logic analyzer triggers and when the oscilloscope triggers.

Acquire the Oscilloscope Data at the Logic Analyzer Trigger Point

1. Open the Horizontal control window of the oscilloscope and adjust the Position to 90% to acquire more data before the oscilloscope triggers.

2. Adjust oscilloscope Horizontal Scale controls for a duration of 2 μs.

Adjusting the oscilloscope waveform duration to 2 μs approximately matches the MagniVu duration.
3. Click **Run** to acquire data. Zoom the data as necessary to see the glitch in the MagniVu waveform and in the oscilloscope waveform.

To further fine-tune the Waveform window, follow the steps under *Adjusting the Time Alignment on the Logic Analyzer.* (See page 34.)
Adjusting the Time Alignment on the Logic Analyzer

Complete the following steps to fine-tune the data alignment.

Zoom the display to measure the time difference between the glitch in the MagniVu waveform and in the oscilloscope waveform:

1. Move Cursor 1 to the leading edge of the glitch in the MagniVu waveform.
2. Click the oscilloscope waveform label to allow you to read the voltage measurements.

3. Move Cursor 2 to the point on the glitch where the waveform crosses the threshold voltage as indicated by the measurement readout.
4. Note the Delta Time value. Double-click the value to select it.
5. Right-click and select Copy.
6. Select **Time Alignment** ... from the Data menu to open the Time Alignment dialog box.

7. Select the oscilloscope from the drop-down list (if it isn’t already selected).

8. Paste the offset value (Delta Time value) into the Adjust time offset box.

9. Click **OK**.

The oscilloscope data is now time-aligned with the logic analyzer data.

**Quick Tips**

- A positive Adjust Time offset value will move the oscilloscope waveform in the display to the right with respect to the logic analyzer data. A negative offset value will move the oscilloscope waveform to the left.
# Index

## A
- Acquiring data, 14
  - iView, 31
- Adding an external oscilloscope, 30
- Address, Tektronix, vi

## B
- Basic steps, 2

## C
- Channel groups
  - creating, 7
  - deleting, 6
  - naming, 7
- Clocking, setting, 8
- Connecting, probes, 1
- Cursors, measuring data, 16

## D
- Data windows, 2
- Deep timing
  - viewing glitches, 23
  - viewing violations, 29
- Default system, 4
- Documentation, v

## E
- Easy Setup wizard, 2
- Easy Trigger, 11

## F
- Force Main Prefill, 22

## G
- Glitch triggering, 20

## I
- Instrument setups, 1
  - iView, 30
    - adjusting oscilloscope data, 32
    - aligning data, 34
  - iView wizard, 30

## L
- Listing window, 2
  - adding columns, 27
  - moving columns, 27
  - opening, 26
  - Loading setups, 20

## M
- MagniVu timing, 17
  - viewing glitches, 22
  - viewing violations, 29
- Maximizing windows, 4
- Measuring data, 16
- Memory depth, setting, 8
- Module icons, Turning modules on and off, 5

## O
- Opening
  - Listing window, 26
  - Setup window, 5
  - Trigger window, 11
  - Waveform window, 12

## P
- Probe connections, 1
- Probes
  - activity, 9
  - threshold voltages, 10
- Product support, vi

## R
- Related documentation, v
- Returning to the System window, 10
- Run/Stop button, 14

## S
- Saving setups, 19
- Service support, contact information, vi
- Setup window
  - acquiring glitches, 23
  - clocking, 8
  - opening, 5
  - setting memory depth, 8

## T
- Target system, connections, 1
- Technical support, vi
- Trigger window
  - Force Main Prefill, 22
  - opening, 11
  - Trigger immediately, 11
  - Trigger on a glitch, 21
  - Trigger on a setup and hold violation, 28
- Triggering
  - glitch, 20
  - setup and hold, 28

## U
- Using the logic analyzer, 2

## V
- Video clip, vi

## W
- Waveform window, 2
- Web site address, Tektronix, vi
- Waveforms
  - adding, 13
  - deleting, 12
- Windows
  - Listing, 2, 26
  - maximizing, 4
  - System, 2
  - System window, returning, 10
  - Trigger
    - defining, 11
    - opening, 11
  - Waveform, 2
    - opening, 12

## Z
- Zooming data, 15